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ในยุคที่การพฒันาเวบ็แอปพลเิคชนักลายเป็นทกัษะพื้นฐานของนักพฒันาเวบ็ไซต์ JSP (JavaServer 
Pages) ยงัคงเป็นหน่ึงในเทคโนโลยทีีม่คีวามส าคญัและทรงพลงัในการสรา้งเวบ็แอปพลเิคชนัแบบไดนา
มกิ ด้วยจุดเด่นของภาษา Java ที่เสถียร ปลอดภยั และได้รบัการสนับสนุนจากเครื่องมอืพฒันา
หลากหลาย JSP จงึยงัคงเป็นรากฐานส าคญัส าหรบัการเรยีนรู ้Full Stack Java Development 

หนังสอื “JSP Web Programming: Beginner” เล่มนี้ ถูกออกแบบมาเพื่อเป็นคู่มอืส าหรบัผู้
เริม่ต้นโดยเฉพาะ โดยครอบคลุมทุกหวัข้อส าคญัที่จ าเป็นต่อการพฒันา JSP ตัง้แต่ขัน้ตอนติดตัง้
สภาพแวดล้อม ไปจนถงึเทคนิคการจดัการขอ้มูล การควบคุม Flow และการจดัการ Error อย่างมอื
อาชพี โดยเนื้อหาไดเ้รยีงล าดบัอยา่งเป็นระบบ พรอ้มค าอธบิายเชงิลกึ ตวัอย่างโคด้ และแนวทางปฏบิตัิ
ทีด่ทีีสุ่ด (Best Practices) เพื่อใหผู้อ่้านสามารถเรยีนรูแ้ละน าไปใชไ้ดจ้รงิ 

เริม่ต้นที ่บทท่ี 1 ผูอ่้านจะไดเ้รยีนรูก้ารตดิตัง้ Java Development Kit (JDK), Apache Tomcat 
และการใช ้IDE ยอดนิยม เช่น Eclipse, IntelliJ IDEA และ NetBeans พรอ้มเทคนิคการเชื่อมต่อกบั 
JSP และการสรา้งโปรเจกต ์JSP เบือ้งตน้อยา่งถูกตอ้ง เพื่อใหส้ามารถรนัและทดสอบ JSP ไดบ้นเครื่อง
ของตนเอง 

ต่อมาใน บทท่ี 2 จะกล่าวถงึโครงสรา้งของไฟล ์JSP โดยละเอยีด ตัง้แต่การใช้ Directives 
(page, include, taglib), การฝัง Java ลงใน HTML ดว้ย Scriptlets และ Expressions ตลอดจนการใช้
งาน Implicit Objects ที่ JSP เตรยีมไว้ให้ใช้งานทนัท ีซึ่งเป็นเครื่องมอืส าคญัในการพฒันาเวบ็ที่
ตอบสนองไดอ้ย่างมปีระสทิธภิาพ บทท่ี 3 เน้นไปทีก่ารจดัการขอ้มลูระหว่าง Client และ Server เช่น 
การรบัค่าจากแบบฟอรม์ผ่าน GET และ POST, การอ่านค่าดว้ย request.getParameter(), การส่งขอ้มลู
กลบัดว้ย response, การใชง้าน Session และ Cookies รวมถงึการส่งต่อขอ้มลูระหว่างหน้า JSP ดว้ย 
RequestDispatcher ซึง่ลว้นเป็นพืน้ฐานของการสรา้งเวบ็แอปแบบอนิเทอรแ์อคทฟี  เมื่อระบบซบัซอ้น
ขึน้ บทท่ี 4 จะพาผูอ่้านไปเรยีนรูก้ารจดัการ Error และ Debugging อย่างมรีะบบ ไม่ว่าจะเป็นการใช้ 
try-catch, การตัง้ Error Page ดว้ย directive, การเขา้ถงึ object exception หรอืการดู Log File จาก 
Apache Tomcat ซึ่งมคีวามส าคญัอย่างยิง่ในการพฒันาระบบที่มคีวามเสถียรและตรวจสอบง่าย 
นอกจากนี้ ยงัม ีภำคผนวก ทีอ่ธบิายเพิม่เตมิเกี่ยวกบั “ตวัแปรใน JSP” และ “JSP Flow Control” ซึง่
จะช่วยปูพื้นฐานการใช้ตวัแปรในแต่ละ scope รวมถงึการควบคุมการท างานของโปรแกรมด้วยค าสัง่
เงือ่นไขและลปู ซึง่ลว้นเป็นทกัษะส าคญัทีใ่ชใ้นการพฒันา JSP ในระดบัจรงิจงั 

ขอให้ผู้อ่านได้รบัประโยชน์สูงสุดจากหนังสอืเล่มนี้ ทัง้ในฐานะคู่มอืการเรยีนรูด้้วยตนเอง และ
เป็นแหล่งอา้งองิในการพฒันาโปรเจกต ์JSP จรงิ พรอ้มกา้วไปสู่การเป็นนักพฒันาเวบ็แอปพลเิคชนัดว้ย 
Java อยา่งมัน่ใจและมรีะบบ. 
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บทท่ี 1 
แนะน า JSP และการติดตัง้สภาพแวดล้อม 

 (Introduction to JSP) 
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Apache Tomcat  
 การสรา้งโปรเจกต ์JSP เบือ้งตน้ใน IDE 
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บทน า: แนะน า JSP และการติดตัง้สภาพแวดล้อม 
ในยุคทีเ่วบ็ไซต์เป็นส่วนส าคญัของการสื่อสาร การใหบ้รกิาร และการด าเนินธุรกจิ JavaServer Pages 
หรอื JSP จงึกลายเป็นเทคโนโลยทีีท่รงพลงัส าหรบัการสรา้งเวบ็แอปพลเิคชนัแบบไดนามกิ JSP ช่วยให้
นักพฒันาสามารถฝังโคด้ Java ลงในหน้า HTML ไดอ้ย่างสะดวก ท าใหส้ามารถเชื่อมต่อกบัฐานขอ้มลู 
ประมวลผลขอ้มลูผูใ้ช ้และควบคุมลอจกิของแอปพลเิคชนัไดอ้ยา่งยดืหยุน่ภายใตโ้ครงสรา้งทีเ่ขา้ใจงา่ย 

JSP ไม่ไดท้ างานแบบเดยีวกบั HTML หรอื Servlet เสมอไป ความแตกต่างทีส่ าคญัคอื HTML 
เป็นเพยีงหน้าแสดงผลแบบคงที ่ไม่สามารถโต้ตอบกบัผูใ้ชไ้ดม้ากนัก ส่วน Servlet คอื Java class ที่
เขยีนลว้น ๆ ไม่ม ีHTML ฝังอยู่ ท าใหก้ารแสดงผลยุ่งยากกว่า JSP ทีร่วมความสามารถทัง้สองไวใ้น
ไฟล์เดยีว ด้วยเหตุนี้ JSP จงึเหมาะส าหรบัการสรา้งอนิเทอรเ์ฟซผู้ใช้ที่ตอบสนองแบบเรยีลไทมแ์ละ
เชื่อมโยงกบั backend ไดอ้ยา่งกลมกลนื 

การท างานของ JSP ม ีLifecycle ทีช่ดัเจน โดยเริม่จากขัน้ตอน Translation ซึง่ JSP ถูกแปลง
เป็น Servlet จากนัน้จงึเขา้สู่ข ัน้ตอน Compilation เพื่อแปลงเป็น Bytecode และสุดทา้ย Execution 
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คอืการรนัภายใน Web Container เช่น Apache Tomcat กระบวนการนี้เกดิขึน้โดยอตัโนมตั ิท าให้
นกัพฒันาไมต่อ้งจดัการเองทุกขัน้ตอน แต่สามารถควบคุมพฤตกิรรมของเวบ็แอปไดต้ามตอ้งการ 

ก่อนเริม่พฒันา JSP นกัพฒันาจ าเป็นต้องตดิตัง้สภาพแวดลอ้มใหพ้รอ้มใชง้าน โดยเริม่จากการ
ตดิตัง้ Java Development Kit (JDK) ซึง่เป็นหวัใจหลกัของการเขยีนโปรแกรม Java ตามด้วย 
Apache Tomcat ซึง่เป็น Web Server/Servlet Container ทีร่องรบั JSP อย่างสมบูรณ์ การตดิตัง้
เครือ่งมอืเหล่านี้อยา่งถูกตอ้งจะท าใหส้ามารถทดสอบและรนัเวบ็แอป JSP ไดภ้ายในเครือ่งของตนเอง 

เพื่อใหก้ารพฒันามปีระสทิธภิาพมากขึน้ นักพฒันาสามารถใช ้IDE (Integrated Development 
Environment) เช่น Eclipse, IntelliJ IDEA หรอื NetBeans ซึง่รองรบัการสรา้งและรนัโปรเจกต์ JSP 
ได้อย่างสะดวก พร้อมเครื่องมอืช่วยเติมค า ตรวจสอบ syntax และ deployment อตัโนมตัิ ช่วย
ประหยดัเวลาในการพฒันาอยา่งมาก 

เมื่อทุกอย่างพรอ้ม นักพฒันาสามารถเริม่ต้นสรา้งโปรเจกต์ JSP เบือ้งต้น เช่น การสรา้งไฟล์ 
.jsp แรกทีแ่สดงค าทกัทาย "Hello, JSP!" และตัง้ค่าโฟลเดอรโ์ปรเจกต์ใหอ้ยู่ในโครงสรา้งทีเ่หมาะสม 
โดยรวมไวใ้น WebContent หรอื webapp ขึน้อยูก่บั IDE ทีเ่ลอืกใช ้พรอ้มเชื่อมโยงกบั Web Server ให้
สามารถเขา้ถงึไดผ้่าน URL 

การรนั JSP บน Local Server นัน้สามารถท าไดผ้่าน Web Browser โดยพมิพ ์URL ตามพอรต์
ที่ก าหนด เช่น http://localhost:8080/HelloJSP/hello.jsp ซึ่งจะน าไปสู่การประมวลผล JSP และ
แสดงผล HTML ที่ถูกแปลงจาก Java Logic ในหน้าเวบ็ การทดสอบบนเครื่องตวัเองนี้จะช่วยให้
นักพฒันาท างานแบบ iterative พฒันา–ทดสอบ–ปรบัปรุง ไดอ้ย่างรวดเรว็ ก่อนน าขึน้เซริฟ์เวอรจ์รงิใน
ขัน้ตอนต่อไป 

บทน านี้เป็นจุดเริม่ต้นส าหรบัผู้เรยีนที่จะก้าวเขา้สู่โลกของ JSP อย่างมัน่ใจ โดยในบทถดัไป 
คุณจะไดล้งมอืเขยีน JSP จรงิ ๆ พรอ้มการประยุกต์ใชง้านร่วมกบัฟอรม์ HTML, ฐานขอ้มลู และเทคนิค
การจดัการสถานะผูใ้ช ้เพื่อสรา้งเวบ็แอปพลเิคชนัทีม่คีวามสมบรูณ์และมอือาชพียิง่ขึน้. 

 
แนะน า JSP และการติดตัง้สภาพแวดล้อม 

 
� 1.1 ความหมายของ JSP และการใช้งานในเวบ็แอป 
JSP (JavaServer Pages) คอืเทคโนโลยขีอง Java ทีช่่วยใหส้ามารถฝัง Java code ลงในไฟล ์HTML 
ไดโ้ดยตรง และแปลผลบนฝัง่ Server ก่อนส่ง HTML กลบัไปยงัผูใ้ช ้(Client) ผ่าน Web Browser 
ลกัษณะเด่นของ JSP: 

 ฝังโคด้ Java ลงใน HTML โดยใช ้<% %> syntax 
 ท างานบน Web Container เช่น Apache Tomcat 
 เหมาะส าหรบัเวบ็แอปทีต่อ้งมกีารตอบสนองแบบ dynamic 
 รองรบัการเชื่อมต่อฐานขอ้มลู, การจดัการ session และ authentication 
 รองรบัการเขยีนแยก logic (Java Bean) กบั UI 
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ตวัอย่างการใช้งาน: 
<html> 
<body> 
    <%  
        String name = "ChatGPT"; 
    %> 
    <h1>Hello <%= name %>!</h1> 
</body> 
</html> 

 
� 1.2 ความแตกต่าง JSP vs Servlet vs HTML ธรรมดา 

ประเภท ลกัษณะการใช้งาน ความเหมาะสม 

JSP HTML + Java Scriptlet เหมาะส าหรบั UI ทีม่ ีlogic แบบ dynamic 

Servlet Pure Java (ไมม่ ีHTML โดยตรง) เหมาะส าหรบัการประมวลผล logic ทีซ่บัซอ้น 

HTML Static markup ใชส้ าหรบัเวบ็เพจธรรมดาทีไ่มเ่ปลีย่นแปลง 

JSP เป็นส่วนต่อยอดจาก Servlet — โดยเบือ้งหลงั JSP จะถูกแปลง (translated) เป็น Servlet ก่อน 
แลว้ค่อย compile และ execute 

 
� 1.3 JSP Lifecycle: Translation, Compilation, Execution 
วงจรการท างานของ JSP ประกอบด้วย 3 ขัน้ตอนหลกั: 

1. Translation Phase (แปล JSP เป็น Servlet) 
o JSP engine จะแปลงไฟล ์.jsp เป็น Java Servlet class (.java) 

2. Compilation Phase 
o Java Compiler จะ compile ไฟล ์.java เป็น .class (Bytecode) 

3. Execution Phase 
o Web Server เรยีกใช ้Servlet class นี้โดยสรา้ง HttpServletRequest และ 

HttpServletResponse 
ภาพรวมการท างาน: 
.jsp → (แปล) → .java → (compile) → .class → (run) → HTML กลบัสู่ client 
หมายเหตุ: Web Container จะท าขัน้ตอนนี้อตัโนมตัใินครัง้แรกที ่JSP ถูกเรยีก 

 
� 1.4 การติดตัง้ JDK และ Apache Tomcat 
ขัน้ตอน: 
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� ติดตัง้ Java JDK (เช่น JDK 17 หรือสงูกว่า) 
 ดาวน์โหลดจาก https://jdk.java.net 
 เพิม่ path ของ JDK ลงในระบบ (เช่น JAVA_HOME, PATH) 

� ติดตัง้ Apache Tomcat (Web Server/Container) 
 ดาวน์โหลดจาก https://tomcat.apache.org 
 แตก zip ไปยงัโฟลเดอรท์ีต่อ้งการ เช่น C:\tomcat 
 เรยีกใชง้านผ่าน bin/startup.bat (Windows) หรอื startup.sh (Linux/Mac) 

ทดสอบ: 
เปิดเบราวเ์ซอรแ์ลว้เขา้ที่ 
http://localhost:8080 
หากเหน็หน้า Tomcat แสดงว่า server ท างานแลว้ 

 
� 1.5 การสร้างโปรเจกต ์JSP เบือ้งต้นใน IDE (Eclipse, IntelliJ) 
� วิธีสร้าง JSP Project บน Eclipse (EE version): 

1. เปิด Eclipse และเลอืกเมนู File → New → Dynamic Web Project 
2. ตัง้ชื่อโปรเจกต ์เช่น HelloJSP 
3. เลอืก Target Runtime เป็น Apache Tomcat ทีต่ดิตัง้ไว ้
4. คลกิ Finish 

โครงสรา้งโปรเจกตจ์ะไดแ้บบน้ี: 
HelloJSP/ 
├── WebContent/ 
│   ├── index.jsp 
├── WEB-INF/ 
│   └── web.xml 
� ตวัอย่างไฟล ์index.jsp: 
<%@ page language="java" contentType="text/html; charset=UTF-8" %> 
<html> 
  <body> 
    <h2>Hello from JSP!</h2> 
    <p>Current time: <%= new java.util.Date() %></p> 
  </body> 
</html> 

 
� 1.6 การรนั JSP บน Local Server และการเข้าถึงผา่นเบราเซอร ์

https://jdk.java.net/
https://tomcat.apache.org/
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ขัน้ตอน: 
1. คลกิขวาที ่Project → Run As → Run on Server 
2. เลอืก Apache Tomcat → Finish 
3. JSP จะรนัที ่URL เช่น 

http://localhost:8080/HelloJSP/index.jsp 
ตวัอย่างผลลพัธใ์นเบราวเ์ซอร:์ 
Hello from JSP! 
Current time: Wed Jul 10 09:25:34 ICT 2025 

 
� สรปุความเข้าใจ 

หวัข้อ สรปุสัน้ 

JSP คอื HTML + Java รนัฝัง่ Server 

ท างานยงัไง แปลงเป็น Servlet → Compile → รนั 

ต่างจาก Servlet JSP เน้น UI, Servlet เน้น Logic 

ตดิตัง้ JDK + Tomcat + IDE (Eclipse/IntelliJ) 

โครงสรา้งไฟล ์ index.jsp, web.xml, WEB-INF/ 

วธิรีนั Run on Server → เปิดผ่านเบราวเ์ซอร ์

 
รายละเอียดเชิงลึก: แนะน า JSP และการติดตัง้สภาพแวดล้อม 
รายละเอียดเชิงลึก: แนะน า JSP และการติดตัง้สภาพแวดล้อม แยกเป็นหวัขอ้ยอ่ย พรอ้มขอ้มลู
เบือ้งหลงัระดบัเทคนิคเพื่อปพูืน้ฐานอยา่งมัน่คงส าหรบัการพฒันา JSP: 

 
� 1.1 ความหมายของ JSP และการใช้งานในเวบ็แอป (JSP Deep Dive) 
JSP คืออะไร? 

 JSP (JavaServer Pages) เป็นเทคโนโลยฝัีง่ server ทีอ่อกแบบมาใหเ้ขยีน HTML ท่ีฝัง Java 
Code ได้ โดยท างานรว่มกบั Servlet API 

 ช่วยใหเ้ขยีนเวบ็แบบ dynamic ไดโ้ดยไมต่อ้งเขยีน Servlet ลว้น ๆ 
 ใชแ้นวคดิคลา้ย PHP, ASP, Razor ทีฝั่งโคด้ server ลงในหน้า HTML 

ท าไมต้องใช้ JSP? 
 ลดภาระในการจดัการ HTML ดว้ย Servlet (ซึง่ตอ้งใช ้out.println() เยอะ) 
 ผสมผสาน HTML + Java อยา่งกลมกลนื 
 รองรบั MVC Pattern โดย JSP ท าหน้าที ่“View” 
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ใช้งานในเวบ็แอปอย่างไร? 
 ทุกค ารอ้งขอ (request) ของผูใ้ช ้เช่นการคลกิลงิก์หรอืส่งฟอรม์ จะถูกส่งไปยงัไฟล์ .jsp 
 JSP จะท างานฝัง่ server สรา้ง HTML ทีเ่หมาะสม แลว้ส่งกลบัไปยงั browser 

sequenceDiagram 
Client->>JSP File: HTTP Request (.jsp) 
JSP File->>JSP Engine: Compile & Translate 
JSP Engine->>Servlet: Execute 
Servlet->>HTML: Generate Response 
HTML->>Client: Send HTML 

 
� 1.2 ความแตกต่างระหว่าง JSP, Servlet และ HTML ธรรมดา 

Feature HTML Servlet JSP 

ประเภท Static Java class Hybrid (HTML + Java) 

ภาษา HTML only Java only HTML + Java 

รนับน Browser Web Container Web Container 

จดุเด่น เรว็, งา่ย Logic จดัเตม็ สะดวกเขยีน UI แบบ dynamic 

โครงสรา้ง UI อยา่งเดยีว ตอ้งใช ้out.write() เขยีน HTML ไดโ้ดยตรง 

เหมาะส าหรบั หน้าเวบ็แบบคงที ่Controller/Business Logic View Template 

� Tip: 
 JSP ถูกแปลงเป็น Servlet เบือ้งหลงั 
 สามารถส่ง Request → Servlet → สรา้งขอ้มลู → Forward มายงั JSP เพื่อ render 

 
� 1.3 วงจรการท างานของ JSP (JSP Lifecycle) 

1. Request มาถึง JSP ครัง้แรก 
2. JSP Engine (ใน Tomcat) ตรวจสอบว่าเคย compile ไฟลน์ี้หรอืยงั 

o ถา้ยงั: แปลง .jsp → .java (extends HttpServlet) 
o แลว้ compile เป็น .class 

3. รนั JSP ท่ีเป็น Servlet แล้ว สรา้ง response ส่งกลบั client 
ภาพรวมไฟลแ์ปลงอตัโนมติั: 
<!-- hello.jsp --> 
<%= "Hello" %> 
จะถูกแปลงเป็น: 
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public class hello_jsp extends HttpServlet { 
   protected void _jspService(HttpServletRequest req, HttpServletResponse res) { 
       res.getWriter().write("Hello"); 
   } 
} 
Lifecycle method ส าคญัของ JSP: 

Method หน้าท่ี 

_jspInit() เรยีกตอนเริม่ JSP 

_jspService() เรยีกทุกครัง้ทีม่ ีrequest 

_jspDestroy() เรยีกตอน JSP ถูกลบ 

 
� 1.4 การติดตัง้ JDK และ Apache Tomcat 
� ติดตัง้ Java JDK 

 ดาวน์โหลด: https://jdk.java.net 
 เพิม่ Environment Variable (Windows): 

o JAVA_HOME → path ทีต่ดิตัง้ JDK 
o PATH → %JAVA_HOME%\bin 

� ติดตัง้ Tomcat 
 ดาวน์โหลด: https://tomcat.apache.org 
 แตก zip → ตัง้ค่า port, log, memory ไดใ้น conf/server.xml 
 ใชง้าน: 

o Windows: bin/startup.bat 
o macOS/Linux: bin/startup.sh 

� ทดสอบ 
เขา้ http://localhost:8080 ตอ้งเหน็หน้า Tomcat dashboard 

 
� 1.5 การสร้าง JSP Project บน IDE (Eclipse / IntelliJ IDEA) 
� Eclipse (Enterprise Edition): 

1. File → New → Dynamic Web Project 
2. ตัง้ชื่อ → เลอืก Target Runtime: Apache Tomcat 
3. หน้า Project Explorer จะม:ี 
4. HelloJSP/ 
5. ├── WebContent/ 

https://jdk.java.net/
https://tomcat.apache.org/
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6. │   └── index.jsp 
7. └── WEB-INF/ 
8.     └── web.xml 

web.xml (Deployment Descriptor): 
<web-app> 
    <welcome-file-list> 
        <welcome-file>index.jsp</welcome-file> 
    </welcome-file-list> 
</web-app> 
หมายเหตุ: ตัง้ค่าให ้index.jsp ท างานโดยอตัโนมตัเิมือ่เปิด root path 

 
� 1.6 การรนั JSP บน Local Server 
วิธีการ: 

 คลกิขวาทีโ่ปรเจกต ์→ Run on Server 
 เลอืก Tomcat 
 รนัที:่ http://localhost:8080/HelloJSP/index.jsp 

การเข้าถึงเบราวเ์ซอร:์ 
http://localhost:8080/HelloJSP/index.jsp 
ข้อผิดพลาดท่ีพบบ่อย: 

Error สาเหตุ 

404 Not Found JSP ไฟลไ์มม่ ีหรอืพมิพ ์path ผดิ 

Port Already in Use มโีปรแกรมอื่นใช ้port 8080 

JSP Compilation Error เขยีน Java code ผดิ syntax 

Server not starting JAVA_HOME หรอื Tomcat path ไมถู่กตอ้ง 

 
� โครงสร้างโปรเจกต ์JSP ท่ีดี (เบือ้งต้น) 
HelloJSP/ 
├── WebContent/ 
│   ├── index.jsp 
│   ├── login.jsp 
│   └── styles/ 
│       └── style.css 
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├── src/ 
│   └── com/example/ 
│       └── LoginServlet.java 
├── WEB-INF/ 
│   ├── web.xml 
│   └── lib/ 
│       └── (JAR dependencies) 

 
� เสริม: เคร่ืองมือท่ีแนะน า 

เครื่องมือ ความสามารถ 

Eclipse EE ท า JSP ไดด้ ีม ีWizard สรา้ง Project 

IntelliJ IDEA Ultimate มตีวัจดัการ Tomcat + JSP Debug 

Tomcat Manager จดัการ App, Restart, Undeploy 

Postman ทดสอบ request เมือ่เริม่ใช ้Servlet 

JSTL + EL ท างานรว่มกบั JSP อยา่งสะอาด 

 
หากคุณตอ้งการ: 
✅ โคด้ JSP แบบเตม็ไฟล ์
✅ ตวัอยา่งหน้า Login + Session 
✅ JSP + JDBC (ฐานขอ้มลู MySQL) 
✅ หรอื JSP + Servlet แบบ MVC 
 

ความหมายของ JSP และการใช้งานในเวบ็แอป 

 
� JSP คืออะไร? 
JSP (JavaServer Pages) คอืเทคโนโลยฝัีง่เซริฟ์เวอรท์ีพ่ฒันาโดย Sun Microsystems (ปัจจบุนัคอื 
Oracle) ซึง่ท างานบน Java EE (Jakarta EE) เพื่อใชส้รา้ง เวบ็เพจแบบไดนามิก (Dynamic Web 
Pages) โดยการฝัง Java code ลงในหน้า HTML ไดโ้ดยตรง 
JSP มลีกัษณะคลา้ย PHP, ASP.NET หรอื Razor ในโลกของภาษาอื่น คอืช่วยใหคุ้ณผสม โค้ดฝัง่
เซิรฟ์เวอร ์กบั HTML ในไฟลเ์ดยีว 
� จดุเด่น: 

 ผสม Java กบั HTML ไดโ้ดยตรง 
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 ใชซ้ ้า code ไดด้ว้ย JSP include, taglib, JSTL 
 ท างานบน Servlet container เช่น Apache Tomcat 
 สามารถเรยีกใช ้JavaBean, JDBC, Session, Cookies ได ้

 
  โครงสร้างพื้นฐานของไฟล ์JSP 
<%@ page language="java" contentType="text/html; charset=UTF-8" %> 
<html> 
<head><title>Welcome</title></head> 
<body> 
    <% 
        String username = "ผูใ้ช"้; 
    %> 
    <h1>ยนิดตีอ้นรบั <%= username %></h1> 
</body> 
</html> 

ส่วนใน JSP ความหมาย 

<%@ page ... %> Page Directive – ก าหนดการตัง้ค่าหน้า 

<% %> Scriptlet – เขยีน Java Code 

<%= %> Expression – แสดงผลค่าตวัแปร 

 
  JSP กบั Web Application: ท างานอย่างไร? 
เมือ่ผูใ้ชร้อ้งขอ (เช่นเปิด URL index.jsp) เบราวเ์ซอรจ์ะส่ง HTTP Request ไปยงัเซริฟ์เวอร ์
เซริฟ์เวอร ์(เช่น Tomcat): 

1. ตรวจสอบไฟล ์.jsp 
2. แปลงเป็น Servlet Java class 
3. Compile → Run → สรา้ง HTML 
4. ส่งกลบั HTML ไปยงัเบราวเ์ซอร ์

⚙  วงจรการท างาน: 
Request → JSP Engine (แปลง JSP → Servlet) → Compile → Run → Response (HTML) 

 
� เปรียบเทียบ JSP กบั HTML ธรรมดา 

คณุสมบติั HTML ธรรมดา JSP 
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คณุสมบติั HTML ธรรมดา JSP 

Dynamic Content ✅ ไมไ่ด ้ ✅ ได ้

ควบคุมดว้ย Java ✅ ไมไ่ด ้ ✅ ได ้

ตดิต่อฐานขอ้มลู ✅ ไมไ่ด ้ ✅ ได ้(ผ่าน JDBC) 

ใชง้าน Session / Cookie ✅ ไมไ่ด ้ ✅ ได ้

ฝัง logic ✅ ไมไ่ด ้ ✅ ท าไดเ้ตม็รปูแบบ 

 
� ตวัอย่างการใช้งาน JSP จริงในเวบ็แอป 
� ไฟล:์ login.jsp 
<form method="post" action="LoginServlet"> 
  Username: <input type="text" name="username" /> 
  Password: <input type="password" name="password" /> 
  <input type="submit" value="Login" /> 
</form> 
� Servlet: LoginServlet.java 
protected void doPost(HttpServletRequest request, HttpServletResponse response) throws 
ServletException, IOException { 
    String user = request.getParameter("username"); 
    String pass = request.getParameter("password"); 
 
    if("admin".equals(user) && "1234".equals(pass)) { 
        request.getSession().setAttribute("user", user); 
        response.sendRedirect("dashboard.jsp"); 
    } else { 
        response.sendRedirect("login.jsp?error=true"); 
    } 
} 
� dashboard.jsp 
<% String user = (String) session.getAttribute("user"); %> 
<h2>Welcome, <%= user %></h2> 

 
� สรปุแนวคิดส าคญั 
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ประเดน็ รายละเอียด 

JSP คอื HTML ทีฝั่ง Java เพื่อสรา้งหน้าเวบ็แบบ dynamic 

ท างานอย่างไร แปลงเป็น Servlet แลว้ compile และ execute 

ใชง้านในเวบ็แอป รบั input จากฟอรม์, เชื่อมฐานขอ้มลู, แสดงผลลพัธ ์

จดุเด่น สะดวกกว่า Servlet, ใช ้Java เตม็รปูแบบ, รนับนเซริฟ์เวอร ์

จดุอ่อน ถา้ logic เยอะ ควรยา้ยไป Servlet แลว้ใช ้JSP แค่ View 

 
ความแตกต่างระหว่าง JSP vs Servlet vs HTML ธรรมดา 

 
✳  เปรียบเทียบภาพรวม: 

คณุสมบติั HTML ธรรมดา Servlet JSP 

ฝัง่ทีป่ระมวลผล 
Client 
(เบราวเ์ซอร)์ 

Server (Java) Server (Java) 

ภาษา HTML, CSS, JS Java ลว้น Java + HTML 

เน้นใชง้าน สรา้ง UI แบบคงที ่ ควบคุม Logic สรา้ง UI แบบ Dynamic 

ท างานรว่มกบั
ฐานขอ้มลู 

✅ ไมไ่ดโ้ดยตรง ✅ ไดเ้ตม็รปูแบบ ✅ ได ้(ผ่าน Java code) 

ประมวลผลแบบ 
Dynamic 

✅ ไมไ่ด ้ ✅ ได ้ ✅ ได ้

เหมาะส าหรบั Static Page 
Business Logic, 
Controller 

View Template, UI 

ตอ้ง Compile? ✅ ไมต่อ้ง ✅ Compile class 
✅ แปลงเป็น Servlet แลว้ 
compile 

ความยดืหยุน่ ต ่า สงู สงู (ดา้น UI) 

 
� 1. HTML ธรรมดา: (Static HTML) 
ลกัษณะ: 

 ใชส้รา้งหน้าเวบ็คงที ่(Static) 
 ไมม่ ีlogic ใด ๆ บนเซริฟ์เวอร ์
 ไมม่กีารเชื่อมต่อฐานขอ้มลูหรอื session 
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 ถูกโหลดและแสดงโดย browser โดยตรง 
ตวัอย่าง: 
<html> 
  <body> 
    <h1>Welcome to my site!</h1> 
  </body> 
</html> 
ข้อดี: 

 โหลดเรว็ 
 งา่ย 

ข้อจ ากดั: 
 ไมม่คีวามสามารถฝัง่เซริฟ์เวอร ์
 ตอ้งใชภ้าษาอื่น (เช่น PHP หรอื JSP) ถา้ตอ้งการ Dynamic content 

 
� 2. Servlet (Java Servlet) 
ลกัษณะ: 

 คอื Java class ที ่implement interface HttpServlet 
 ใชจ้ดัการ request/response โดยตรง เช่น การอ่าน form, เขยีน HTML ดว้ย Java 
 ท างานผ่าน Servlet Container (เช่น Apache Tomcat) 
 ตอ้ง compile และ deploy 

ตวัอย่าง: 
@WebServlet("/hello") 
public class HelloServlet extends HttpServlet { 
  protected void doGet(HttpServletRequest req, HttpServletResponse res) 
      throws ServletException, IOException { 
    PrintWriter out = res.getWriter(); 
    out.println("<html><body>"); 
    out.println("<h1>Hello from Servlet</h1>"); 
    out.println("</body></html>"); 
  } 
} 
ข้อดี: 

 เขยีน logic ไดย้ดืหยุน่มาก 
 เชื่อมต่อฐานขอ้มลู, ตรวจสอบ session, ค านวณไดเ้ตม็ที ่
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ข้อจ ากดั: 
 การเขยีน HTML ดว้ย Java ท าใหโ้คด้ดรูก 
 ไมเ่หมาะกบังานดา้น UI 

 
� 3. JSP (JavaServer Pages) 
ลกัษณะ: 

 ไฟล ์.jsp ทีผ่สม HTML กบั Java ได ้
 เหมาะกบัการแสดงผลลพัธท์ี ่dynamic เช่นตาราง, ฟอรม์, รายการ 
 ฝัง Java scriptlet (<% %>) ลงใน HTML ไดโ้ดยตรง 
 เบือ้งหลงัจะถูกแปลงเป็น Servlet โดยอตัโนมตั ิ

ตวัอย่าง: 
<%@ page language="java" contentType="text/html; charset=UTF-8" %> 
<html> 
<body> 
  <h1>Hello JSP</h1> 
  <% out.print("Today: " + new java.util.Date()); %> 
</body> 
</html> 
ข้อดี: 

 สะดวกในการเขยีน UI 
 อ่านงา่ยกว่า Servlet 
 ใชร้ว่มกบั JSTL, EL ได ้เพื่อแยก logic ออกจาก view 

ข้อจ ากดั: 
 ไมเ่หมาะกบั logic ทีซ่บัซอ้น 
 ถา้ฝัง Java เยอะเกนิ จะอ่านยากและดไูมเ่ป็นระเบยีบ (Anti-pattern) 

 
การท างานรว่มกนั (Best Practice) 
ในระบบขนาดกลางขึน้ไป ควรใช ้JSP และ Servlet ร่วมกนัในรปูแบบ MVC (Model-View-
Controller): 

 Servlet = Controller → ประมวลผลขอ้มลู, เรยีกฐานขอ้มลู, จดัการ session 
 JavaBean / DAO = Model → โคด้เชงิธุรกจิและขอ้มลู 
 JSP = View → แสดงผลใหผู้ใ้ชเ้หน็ 

ตวัอย่าง Flow: 
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[Browser] → [Servlet] → [JavaBean/Database] → [set data in request] → [JSP View] 

 
� สรปุความแตกต่างแบบกระชบั 

หวัข้อ HTML Servlet JSP 

ต าแหน่งประมวลผล Client Server Server 

เหมาะกบั Static Page Logic/Controller UI/View 

เขยีน HTML ✔  โดยตรง ✅ ตอ้งใช ้out.println() ✔  สะดวก 

ฝัง Java ไดไ้หม ✅ ✔  เตม็รปูแบบ ✔  จ ากดัเฉพาะ UI logic 

ซบัซอ้น งา่ยมาก ซบัซอ้น ปานกลาง 

 
JSP Lifecycle: Translation, Compilation, Execution 
หรอื "วงจรการท างานของ JSP" ตัง้แต่ผูใ้ชร้อ้งขอไฟล ์.jsp จนไดร้บัหน้าเวบ็ทีแ่สดงผลลพัธ ์

 
� ภาพรวม JSP Lifecycle 
เมือ่ผูใ้ชร้อ้งขอ (request) ไฟล ์.jsp ผ่านเบราวเ์ซอร ์เช่น http://localhost:8080/Hello/index.jsp 
เซริฟ์เวอร ์(เช่น Apache Tomcat) จะประมวลผลไฟล ์.jsp ดว้ย ขัน้ตอนต่อไปน้ี: 
1. Translation Phase (แปล JSP → Java Servlet class) 
2. Compilation Phase (compile Java class → .class) 
3. Loading & Instantiation Phase (โหลดและสรา้ง instance) 
4. Initialization (_jspInit()) 
5. Execution (_jspService()) 
6. Destruction (_jspDestroy()) 

 
� 1. Translation Phase (การแปล JSP เป็น Servlet) 

 JSP Engine จะตรวจสอบว่าไฟล ์.jsp ถูกแปลและ compile แลว้หรอืยงั 
 ถา้ยงั → จะ แปลง JSP → Java Servlet class (.java) โดยใชโ้ครงสรา้งของ HttpServlet 
 JSP แต่ละไฟลจ์ะถูกแปลงเป็น Java class ทีม่ชีื่อ เช่น index_jsp.java 

� ตวัอย่าง: 
<!-- index.jsp --> 
<h1>Hello JSP</h1> 
<%= new java.util.Date() %> 
จะถูกแปลงเป็น: 
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public final class index_jsp extends HttpServlet { 
    public void _jspService(HttpServletRequest request, HttpServletResponse response) 
    throws IOException, ServletException { 
        JspWriter out = response.getWriter(); 
        out.write("<h1>Hello JSP</h1>"); 
        out.write(new java.util.Date().toString()); 
    } 
} 
ไฟล ์.java นี้จะถูกเกบ็ไวใ้นโฟลเดอรช์ัว่คราว เช่น work/Catalina/localhost/project/org/apache/jsp 

 
� 2. Compilation Phase (การคอมไพล ์Java class เป็น Bytecode) 

 Java Compiler จะ compile ไฟล ์.java → .class (bytecode) 
 ท าใหไ้ฟล ์.class พรอ้มถูกโหลดเขา้สู่ JVM 
 กระบวนการนี้เกดิขึน้ โดยอตัโนมติั ในครัง้แรกที ่JSP ถูกรอ้งขอ 

 
� 3. Loading & Instantiation Phase (โหลด class และสร้าง object) 

 Web Container (Tomcat) โหลด class ที ่compile แลว้เขา้สู่ JVM 
 สรา้ง instance ของ servlet ทีไ่ดจ้าก JSP 
 เกบ็ไวใ้น memory และใชซ้ ้าใน request ถดัไป 

 
� 4. Initialization Phase (_jspInit() method) 

 เรยีกใชเ้มธอด _jspInit() เพยีงครัง้เดยีวตอนที ่JSP ถูกโหลด 
 ใชส้ าหรบัเตรยีมการ (Initialization) เช่นเปิด connection ล่วงหน้า หรอืโหลด config 

public void _jspInit() { 
   // เช่น โหลด Resource, อ่าน Properties 
} 

 
� 5. Execution Phase (_jspService() method) 

 เรยีกใชเ้มธอด _jspService(HttpServletRequest req, HttpServletResponse res) ทุกครัง้ท่ีมี
ค าร้องขอ (request) 

 เป็นเมธอดหลกัทีใ่ช ้สร้าง HTML output และตอบกลบั client 
public void _jspService(HttpServletRequest req, HttpServletResponse res) { 
    // สรา้ง HTML ดว้ย out.write() 
} 
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Developer ไมส่ามารถ override _jspService() ไดด้ว้ยตนเอง 

 
� 6. Destruction Phase (_jspDestroy() method) 

 เรยีกเมือ่ JSP ถูกถอดออกจาก memory (undeployed หรอื server ปิดตวัลง) 
 ใชส้ าหรบัการ ปิด resource, ปิด connection, clean up memory 

public void _jspDestroy() { 
   // เช่น conn.close(); 
} 

 
� สรปุ JSP Lifecycle แบบภาพรวม 
graph TD 
A[Client Request: index.jsp] --> B[Translation: index.jsp → index_jsp.java] 
B --> C[Compilation: index_jsp.java → index_jsp.class] 
C --> D[Loading & Instantiation: โหลด class เขา้สู่ JVM] 
D --> E[_jspInit(): เรยีกเมื่อโหลดครัง้แรก] 
E --> F[_jspService(): เรยีกทุกครัง้ทีม่ ีrequest] 
F --> G[Response: ส่ง HTML กลบัไปยงั Client] 
G --> H[_jspDestroy(): เมื่อ server ปิดหรอื reload] 

 
� หมายเหตเุรื่อง "Cache" 

 JSP จะไมแ่ปลงใหมทุ่กครัง้ ถา้ไฟล ์.jsp ยงัไม่ถกูแก้ไข 
 หากคุณแกไ้ข JSP แลว้ save, Container จะ detect การเปล่ียนแปลงแล้วแปลใหม่ 
 ดงันัน้ JSP เหมาะกบัการพฒันาเวบ็ทีป่รบัเปลีย่น UI บ่อย 

 
� สรปุตาราง JSP Lifecycle 

ขัน้ตอน รายละเอียด 

1. Translation JSP → Java Servlet (.java) 

2. Compilation Java → Bytecode (.class) 

3. Loading โหลด .class เขา้ JVM 

4. _jspInit() เรยีกครัง้แรกตอนเริม่ใชง้าน 

5. _jspService() เรยีกทุก request 

6. _jspDestroy() เรยีกตอน shutdown/unload 
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การติดตัง้ JDK และ Apache Tomcat 

 
1. การติดตัง้ JDK (Java Development Kit) 
JDK คอืชุดเครือ่งมอืส าหรบัพฒันาโปรแกรมภาษา Java ซึง่ประกอบดว้ย 

 Java Compiler (javac) 
 Java Runtime Environment (JRE) 
 Java libraries และ tools อื่น ๆ 

 
ขัน้ตอนติดตัง้ JDK 
1.1 ดาวน์โหลด JDK 

 เขา้เวบ็ไซต์ https://jdk.java.net หรอื Oracle JDK 
 เลอืกเวอรช์นัทีต่อ้งการ เช่น JDK 17 LTS (Long Term Support) หรอืเวอรช์นัล่าสุด 

1.2 ติดตัง้ JDK 
 รนัไฟลต์ดิตัง้ทีด่าวน์โหลดมา 
 เลอืกโฟลเดอรต์ดิตัง้ เช่น 

o Windows: C:\Program Files\Java\jdk-17.0.x 
o macOS/Linux: /Library/Java/JavaVirtualMachines/jdk-17.0.x.jdk/Contents/Home 

1.3 ก าหนด Environment Variables 
Windows: 

 เปิด System Properties > Advanced > Environment Variables 
 สรา้งตวัแปรใหม่ JAVA_HOME ชีไ้ปทีโ่ฟลเดอร ์JDK เช่น 

C:\Program Files\Java\jdk-17.0.x 
 แกไ้ขตวัแปร Path เพิม่ 

%JAVA_HOME%\bin 
macOS/Linux: 

 แกไ้ขไฟล ์~/.bash_profile หรอื ~/.zshrc เพิม่บรรทดั 
 export JAVA_HOME=/path/to/jdk 
 export PATH=$JAVA_HOME/bin:$PATH 
 รนัค าสัง่ source ~/.bash_profile เพื่อโหลด config ใหม ่

1.4 ตรวจสอบการติดตัง้ 
เปิด Command Prompt หรอื Terminal แลว้พมิพ:์ 
java -version 
javac -version 

https://jdk.java.net/
https://www.oracle.com/java/technologies/downloads/
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